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Chapter 1 General Interface Migration Paths

This manual explains how to migrate projects from previous General Interface releases to the
current release.

The migrations paths are as follows:

General Interface 3.0 to 3.4
The migration path is 3.0 > 3.1.x > 3.2 or 3.3 > 3.4. See .Migrating Projects from 3.0 to 3.4
General Interface 3.1.x to 3.4
The migration path is a direct migration from 3.1.x > 3.2 or 3.3 > 3.4. See Migrating

.Projects from 3.1.x to 3.4
General Interface 3.2 or 3.3 to 3.4
The migration path is 3.2 or 3.3 > 3.4. See .Migrating Projects from 3.2 or 3.3 to 3.4
General Interface 3.4 to 3.5.
No migration is required from General Interface 3.4 to 3.5.
For more information on General Interface, see General Interface Release Notes.
General Interface 3.4 or 3.5 to version 3.6-3.8.
No migration is required from General Interface 3.4 or 3.5 to version 3.6-3.8, but there is a
change in behavior from previous version.
See  for information about how to modify your applicationMigrating Projects to 3.6 or 3.7
if it uses the  file.<resourcename>.meta.xml
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Chapter 2 Migrating Projects from 3.0 to 3.4

This chapter discusses how to migrate General Interface 3.0 - Enterprise Edition projects to 3.4.
The migration path is 3.0 > 3.1.x > 3.2 or 3.3 > 3.4. No migration is required from 3.2 to 3.3.

Installation and Set Up for 3.0 to 3.4 Migration
Required Steps for 3.0 to 3.4 Migration

Installation and Set Up for 3.0 to 3.4 Migration

Before you migrate your General Interface 3.0 - Enterprise Edition projects to 3.4, you must
migrate to 3.1.x and 3.3. First, complete these steps to migrate your 3.0 projects to 3.1.x:

Install General Interface 3.1.x - Enterprise Edition.
Make backup copies of your projects before migrating.
Copy projects that you would like to migrate from the 3.0  folder into the 3.1.x JSXAPPS

 folder.JSXAPPS

Double-click  in the 3.1.x installation directory to start General InterfaceGI_Builder.html

Builder.

Required Steps for 3.0 to 3.4 Migration

Complete the following steps to migrate your General Interface 3.0 projects to 3.1.x. After you
migrate to 3.1.x, you need to migrate to 3.3 and 3.4.

Open all projects and project files in General Interface Builder 3.1.x to update all
component files to the new 3.1.x package structure. Component files are automatically
converted to the new 3.1.x GUI package structure and the serialization files are also
updated.
Modify all class names and constructors in your JavaScript logic files to the new 3.1.x
package structure. For more information, see Package Reorganization in General
Interface Release Notes.
Modify JavaScript code due to changes in 3.1.x. Read the following topics to see if you
need to modify your code: 

Class Hierarchy Related to jsx3.gui.BlockX 
Checking for Equality against Model.getInstanceOf() 
Model.findDescendants() Results Order 
List.selectRecord() and Model Events

If your projects use data mapping, update the project as described in Data Mapping for
.3.0 to 3.4 Migration

Migrate the updated 3.1.x projects to 3.3 and 3.4 as described in Migrating Projects from
.3.1.x to 3.4

Data Mapping for 3.0 to 3.4 Migration

This section explains the steps for migrating General Interface 3.0 projects that use data
mapping to General Interface 3.1.x.
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For data mapping, there are two steps to updating your project:

Update rules files.
Update JavaScript code.

Updating Rules Files

Update mapping rules files to the 3.1.x format. Simply open each rules file in the XML Mapping
Utility (formerly SOAP Mapping Utility) in General Interface Builder 3.1.x and save. The rules
file is automatically updated to the 3.1.x format. To open the XML Mapping Utility, choose 

 XML Mapping Utility. You'll also need to do this in GeneralTools > Communication >
Interface Builder 3.2 or 3.3.

Updating JavaScript Code

There are two steps for updating JavaScript code to 3.1.x:

Update the function code that calls the service.
Update method calls that are associated with GUI objects.

Updating the Function Code

The code for calling the  has changed and needs to be updated to use the new jsx3.Service

jsx3.net.Service.

To update the function code that invokes the service, complete these steps:

Open the mapping rules file in General Interface 3.1.x.
Click the Generate button on the XML Mapping Utility toolbar and choose the operation
from the drop-down list.
Replace the 3.0 function code in the JavaScript logic file with the new 3.1.x function code.

Updating Method Calls

You also need to replace any method calls in your JavaScript code that are associated with GUI
objects with the new method calls.

Class Hierarchy Related to jsx3.gui.BlockX

In General Interface 3.0, , , , and  alljsx3.List jsx3.Select jsx3.Tree jsx3.chart.ChartComponent

extended . These classes inherited the methods for storing XML and XSL data in thejsx3.BlockX

application cache from BlockX.

In 3.1.x, these methods have been moved to the mixin interface, . Therefore,jsx3.xml.Cacheable

, and  no longerjsx3.gui.List, jsx3.gui.Select, jsx3.gui.Tree jsx3.chart.ChartComponent

extend . Any code that relied on this specific 3.0 class hierarchy will not workjsx3.gui.BlockX

in 3.3. For example, the following code will not work:

function alertIfCDF(objControl) {
   (objControl.isInstanceOf("jsx3.gui.BlockX"))if
      objControl.getServer().alert("Alert", objControl.getName() +
      " is a CDF control");
}

It should be changed to:
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function alertIfCDF(objControl) {
   (objControl.instanceOf(jsx3.xml.CDF))if
      objControl.getServer().alert("Alert", objControl.getName() +
      " is a CDF control");
}

The method  is similarly affected.isSubclassOf()

Checking for Equality against Model.getInstanceOf()

The  method has been deprecated in 3.1. (The Class Inheritancejsx3.Model.getInstanceOf()

and Introspection document describes the preferred methods for determining whether an object
is an instance of a class or interface.) Because of the package reorganization in 3.1, the 

 method does not always return the same value as in 3.0. For example, if getInstanceOf()

 returned  in 3.0, it will return  in 3.1. Therefore, anygetInstanceOf() jsx3.Block jsx3.gui.Block

code that checks the return value of  for equality will likely break in 3.1.getInstanceOf()

For example,

//  will   3.1this break in
 (objBlock.getInstanceOf() == "jsx3.Block")if

    objBlock.getServer().alert("Alert", "It's a block!");

Model.findDescendants() Results Order

General Interface 3.0 included a defect in the  method thatjsx3.Model.findDescendants()

caused the results to be returned in reverse order. This was in violation of the method contract
that said the results would be returned in either depth-first or breadth-first order. This defect is
fixed in 3.1. However, any code that relied on the order of the results from this method may
break in 3.1.

The following methods that call find  are also affected: Descendants()

, and Model.getDescendantOfName(), Model.getFirstChildOfType()

. The  method would be similarly affected.Model.getDescendantsOfType() isSubclassOf()

List.selectRecord() and Model Events

The contract of the  method has changed. In 3.0, it caused thejsx3.gui.List.selectRecord()

SELECT model event to fire. In 3.1, it never caused the model event to fire. This change is
related to the new 3.1 model event protocol detailed in the Model Events document. For an
application running under the 3.0 model event protocol to continue to function properly in 3.1, 

 should be replaced with .Otherwise, the application mustList.selectRecord() List.doSelect()

be upgraded to the 3.1 model event protocol. All other methods affected by the new event
protocol are backwards compatible in 3.1.
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Chapter 3 Migrating Projects from 3.1.x to 3.4

This chapter explains how to migrate your General Interface 3.1.x - Enterprise Edition projects
to 3.4. The migration path is 3.1.x > 3.2 or 3.3 > 3.4. No migration is needed from 3.2 to 3.3.

The migration steps fall into two categories: required and optional. If your application will be
deployed on Firefox, also complete the steps in .Migrating Projects for Firefox for 3.1.x to 3.4

Browsers and Layouts for 3.1.x to 3.4 Migration
Class Loading in Migration for 3.1.x to 3.4 Migration
Data Mapping for 3.1.x to 3.4 Migration
Installation and Set Up for 3.1.x to 3.4 Migration
Migrating Projects for Firefox for 3.1.x to 3.4
Optional Migration Steps for 3.1.x to 3.4 Migration
Project Settings for 3.1.x to 3.4 Migration
Relative Paths for 3.1.x to 3.4 Migration
Required Migration Steps for 3.1.x to 3.4 Migration
Required Steps for Firefox for 3.1.x to 3.4 Migration
XSL Changes for 3.1.x to 3.4 Migration

Browsers and Layouts for 3.1.x to 3.4 Migration

To avoid unexpected layout behavior when using relative positioning, such as misaligned GUI
components, it's recommended to use Block as a container  if it meets at least  of theseonly one
requirements:

The Block is owned by a layout manager, such as LayoutGrid, Tab, Stack, and Splitter.
The Block is relatively positioned and has a width of 100%.
The Block is absolutely positioned.

Class Loading in Migration for 3.1.x to 3.4 Migration

General Interface 3.3 supports dynamic class loading for more efficient performance. Dynamic
class loading, also known as lazy loading, means that classes are loaded as they're needed at the
last possible moment.

jsxlt Parameter

The  parameter is no longer supported in 3.4. If you're migrating to 3.4, skipjsxlt

this topic.

The  deployment parameter is a runtime configuration parameter that determines howjsxlt

classes are loaded. The  deployment parameter is located in the  element on thejsxlt script

web page that launches the deployed application. For example,
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<script type=  src="text/javascript" "JSX/js/JSX30.js"
   jsxapppath=" ../workspace/JSXAPPS/PROJECT_DIR/"
   jsxmanualhome="true"
   jsxlt="true"
   >
</script>

When the  deployment parameter is set to , the default setting, all required classes arejsxlt true

loaded as the system initializes. Optional classes are loaded by the component file and the 
 method.jsx3.require()

If you don't want to use dynamic loading for your 3.1.x classes, set the  parameter to falsejsxlt

( ) or remove it. However, if you want to take advantage of dynamic classjsxlt="false"

loading, you need to add the  parameter to your launch page or create a new launch pagejsxlt

with the General Interface 3.3 Deployment Utility (Project > Deployment Utility).

jsx3.require() Method

The  method can be used to load classes explicitly. Use the fully qualified classjsx3.require()

name when using the  method. For example,jsx3.require()

jsx3.require("jsx3.net.Form");

Only classes that can be found by the system class loader are loaded. Custom classes can be
added on the Classpath panel of the Project Settings dialog (formerly Deployment Options). To
open the Project Settings dialog, choose .Project > Project Settings

When a component file is deserialized, the class of each object encountered in the file is
dynamically loaded if it's not already loaded. Therefore, it's often not necessary to use the 

 method with classes that descend from jsx3.app.Model. However, if JavaScriptjsx3.require()

code references these classes and if the code executes before a deserialization automatically
loads the class, you must use the  method to explicitly load the class.jsx3.require()

The  method must be called at least once before making these types ofjsx3.require()

references:

A static reference to a class descending from  (typically ).jsx3.gui.Model jsx3.gui.**

Any references to subclasses of  that execute before the class is loaded throughModel

object deserialization.

The General Interface Builder debugger classes are dynamically loaded. To use the
JavaScript Step Through Debugger in General Interface Builder, you must use the 

 method before any  statements to load debuggerjsx3.require() jsx3.ide.debug()

classes. For example,  ;jsx3.require("jsx3.ide.Debugger")

Data Mapping for 3.1.x to 3.4 Migration

This section explains the steps for migrating General Interface 3.1.x projects that use data
mapping to General Interface 3.2 and 3.3.

For data mapping, there are two steps to updating your project:
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For data mapping, there are two steps to updating your project:

Update rules files.
Modify the  method call in the JavaScript code.loadResource()

Updating Rules Files

The format of data mapping rules files has changed in General Interface releases after 3.1.x.
Mapping rules files from 3.1.x will not run in 3.3. General Interface Builder includes logic for
converting 3.1.x rules files to 3.3. Simply open each 3.1.x rules file in the XML Mapping Utility
(formerly SOAP Mapping Utility) in General Interface Builder 3.3 and save it. The 3.1.x rules
file is automatically updated to the 3.3 format. To open the XML Mapping Utility, choose Tools

.> Communication > XML Mapping Utility

Modifying the loadResource() Method Call

The JavaScript code generated by the XML Mapping Utility has changed due to a signature
change in the  method ( ). The rules file ID is now passed as aloadResource() jsx3.app.Server

parameter instead of the URL. Update all legacy code generated by the XML Mapping Utility as
shown in the , below.New Code for 3.3

Code for 3.1.x
var objService =  jsx3.net.Service(Rules_File_URL, Operation_Name);new
objService.setNamespace(namespace);

New Code for 3.3
var objService = Server_Name.loadResource(Project_Resource_File_Id);
objService.setOperation(Operation_Name);

setOutboundStubURL() and setInboundURL() Methods

Note that these URLs are now resolved relative to the context server. For example, if the project
directory for the context server is , then the following inputs are valid and equivalent: test

jsxapp://test/xml/typical.xml

xml/typical.xml

JSXAPPS/test/xml/typical.xml

If the  project directory is nested in a subdirectory, such as , then thetest JSXAPPS/samples/test

following inputs are valid and equivalent: jsxapp://samples/test/xml/typical.xml
samples/test/xml/typical.xml

JSXAPPS/samples/test/xml/typical.xml

Installation and Set Up for 3.1.x to 3.4 Migration

Before you can migrate your General Interface 3.1.x projects to 3.4, you need to migrate to 3.3.
Complete these steps to migrate your 3.1.x projects to 3.3:

Install General Interface 3.3. For more information about installing General Interface, see
General Interface Installation.
Double-click  or  in the installation directory to startGI_Builder.html GI_Builder.xhtml

General Interface Builder in Firefox or Internet Explorer.
Choose or create a workspace directory after General Interface Builder initializes. The 

 is the directory that contains your projects, custom add-ins, customworkspace
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 is the directory that contains your projects, custom add-ins, customworkspace

prototypes, and your user settings for General Interface Builder. Separation of the
General Interface install directory from the workspace allows for easier application
deployment. For more on workspaces, see the General Interface Developer Guide.
Make backup copies of all projects you are migrating.
Copy projects that you would like to migrate to 3.3 from your previous  folderJSXAPPS

into your new  folder./JSXAPPSworkspace

Copy any custom user prototypes from your  directory to the user/prototypes workspace

 directory. Components saved to this folder display in the  folder of the/prototypes User

Component Libraries palette.
Copy any custom add-ins to the  or  directory. Typically,JSX/addins /addinsworkspace

add-ins to be used by a team of developers would be saved to the  directoryJSX/addins

and posted by an administrator to a location accessible to the team. Add-ins for
individual use can be saved to the  directory./addinsworkspace

Migrating Projects for Firefox for 3.1.x to 3.4

This section discusses how to migrate projects to be deployed on Firefox from 3.1.x to 3.3.

GUI Components

Replace all deprecated List and Grid components with Matrix components. List and Grid are
not supported in Firefox.

Character Encoding

Projects that were localized prior to General Interface 3.2 may have been saved in UTF-16
encoding. If you open these files in General Interface 3.3, they might contain junk characters.
Although General Interface 3.3 might read these Unicode files, it's best to resave the project in
General Interface Builder 3.3 on Internet Explorer before you proceed with the project
migration. Be sure to make a backup of your project before beginning.

For applications loaded from the local disk, such as General Interface Builder, Firefox reads
only non-XML files that are encoded in a standard 8-bit encoding. Firefox can read local XML
files in any encoding supported by the host system only if the encoding is included in the XML
declaration.

To re-encode any non-XML files from UTF-16 to 8-bit ASCII, you can use General Interface
Builder 3.3 running in Internet Explorer or a text editor.

To re-encode non-XML files from UTF-16 to 8-bit ASCII, complete these steps:

Open General Interface Builder in Internet Explorer.
Choose  to open the IDE Settings dialog.Tools > IDE Settings
Make sure the  field is blank.Output character encoding
Open and re-save each file.

You will not be able to include any non-ASCII characters in these plain text files. For the best
compatibility with Firefox, all extended ASCII and 16-bit characters should be externalized in
XML files that declare their character encoding in the XML declaration.

XML files do not need to be re-encoded as described above, although they can be. However, if
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XML files do not need to be re-encoded as described above, although they can be. However, if
an XML file is encoded in UTF-16 or any other non-ASCII character encoding, the encoding
must be added to the XML declaration. Add or modify the first line of the XML file with the
following XML declaration:

<?xml encoding= ?>"UTF-16"

Note that component serialization files are also XML files. If they have been encoded in UTF-16,
they must also be modified as described above.

XPath and XSLT Requirements

XSL must meet these requirements to work properly in Firefox:

The XSL must include the following namespace:

xmlns:xsl="http://www.w3.org/1999/XSL/Transform"

* The XSL must output valid XML. Balanced tags are required. For example,

<xMessage>Hello World!</xMessage>

The only output formats supported for XSLT processing are HTML 4.0 and XML. 
XSLT implementation does not support the namespace axis, limiting the ability to
query and discover namespaces. The DOM-based interface also fails to implement
this axis. 
XSLT implementation does not support the  method, which means thatnode-set()

complex parameters and result tree fragments cannot be resolved. 
XSLT implementation does not allow output escaping to be disabled, which
means that escaped entities cannot be resolved during a transformation.

Optional Migration Steps for 3.1.x to 3.4 Migration

The following steps are optional:

Manually merge your customized  files with the new logging systemlogger.xml

configuration file ( )./logger.xmlGI_HOME

In General Interface 3.2 and later releases, the  file has new attributes andlogger.xml

functionality, such as sound for the logging system and class loading options. The
logging file has also been moved from the  directory to  and must be/JSXGI_HOME GI_HOME

deployed accordingly. For more information, see the General Interface Developer Guide.
To take advantage of MSXML 4 or later, if installed, remove the Internet Explorer
parameters from the application configuration file. See .Internet Explorer Parameters
For consistent layout behavior in both Firefox and Internet Explorer using a Block, follow
the recommendations specified in .Browsers and Layouts for 3.1.x to 3.4 Migration
Change paths to relative URLs for more flexible development and deployment. See 

.Relative Paths for 3.1.x to 3.4 Migration
Replace all deprecated List and Grid components with Matrix components. Note that
List and Grid are not supported in Firefox.
Rename resource files from .jss to .xml for easier deployment. For example, Microsoft
IIS6 Server doesn't handle the .jss file extension correctly. Renaming resource files with

the .xml extension prevents such deployment problems.
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the .xml extension prevents such deployment problems.

Project Settings for 3.1.x to 3.4 Migration

When you create a new project in General Interface Builder, a default application configuration
file is automatically created as part of the project in the project directory: workspace

. The application configuration file contains application/JSXAPPS/project_dir_/config.xml

configuration data, such as project settings, application deployment, and file locations.

You can modify the project settings in the Project Settings dialog (Project > Project Settings) or
in the application configuration file. Any changes you make in the Project Settings dialog are
saved to the configuration file. Some changes can only be made in the configuration file.

Paths

Application resources can now be specified using relative paths, which allows for easier
portability of code from one project to another and simplifies the relocation of applications in
the  folder hierarchy.JSXAPPS

When you open a 3.1.x project in General Interface Builder 3.3, paths in the  file areconfig.xml

updated automatically to relative paths after the upgrade prompt.

However, you must modify the path for the initial component. You can do this on the
Deployment panel of the Project Settings dialog (Project > Project Settings) in the IDE or in the
application configuration file ( ). Simply remove /JSXAPPS/PROJECT_DIR_/config.xmlworkspace

 from the path as shown in the  below.JSXAPPS/PROJECT_DIR_/ Revised config.xml for 3.3

config.xml for 3.1.x
<record jsxid="objectseturl"
  type= >JSXAPPS/PROJECT_DIR/components/appCanvas.xml"string"
</record>

Revised config.xml for 3.3
<record jsxid="objectseturl"
  type= >components/appCanvas.xml"string"
</record>

Auto Load Options

New file auto load options have been introduced in General Interface 3.2. In prior General
Interface releases, auto loading could be set to true or false. In General Interface 3.2 and above,
there are four auto load options: Manually as needed, At init, At full init, and At light init.
Available options vary by file type. For more information about auto load options, see the
General Interface Developer Guide.

Before using the new options, you need to modify the  jsxid for some files in theonLoad

application configuration file as follows:

Open the application configuration file, which is located in workspace
./JSXAPPS/PROJECT_DIR_/config.xml

Find  and notice that there are multiple records of type . Each type jsxid="includes" map

 record has a record with  "  ".map jsxid= onLoad

Modify each child record of type  with a jsxid of  as follows: map onLoad
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Modify each child record of type  with a jsxid of  as follows: map onLoad

Change the jsxid  value to . onLoad load

Change the type from  to . boolean number

Change the record value to the new desired value, such as . For0, 1, 2, or 3

values, see the next table.
For example, to set  to load automatically when the applicationlogic.js

initializes, change the record from this:

<record jsxid=  type= >"onLoad" "boolean" true</record>

To this:

<record jsxid=  type= >"load" "number" 1</record>

Auto Load Option 3.2 or 3.3 Prior to 3.2

Manually as needed 0 false

At init 1 true

At full init 2 Not available

At light init 3 Not available

The Auto Load option is disabled for GUI component files, such as . You canappCanvas.xml

specify a GUI component file to automatically load when the application initializes in the Initial
Component field on the Deployment panel of the Project Settings dialog.

Save the configuration file and reload the project.

Once you've modified the application configuration file, you can also set auto load options in
General Interface Builder. Right-click a file in the Project Files palette and choose Edit Profile.
Select an option from the Auto Load drop-down list in the Edit Profile dialog and click Save.

Internet Explorer Parameters

To take advantage of MSXML 4 or later, if installed, remove the following Internet Explorer
parameters from the application configuration file.

Open the application configuration file: /JSXAPPS/PROJECT_DIR_/config.xml.workspace

Remove the following Internet Explorer-specific parameters:

<record jsxid="xmlregkey"
    type= >Msxml2.FreeThreadedDOMDocument.3.0"string" </record>
  <record jsxid="xslregkey"
    type= >Msxml2.XSLTemplate.3.0"string" </record>
  Msxml2.XMLHTTP<record jsxid=  type= >"httpregkey" "string" </record>

However, you can pass these parameters at runtime using the General Interface runtime
parameters. See the General Interface Developer Guide.

Custom Add-ins

If you've created a custom add-in for General Interface 3.1.x, you need to edit the project 
 file of the add-in as follows:config.xml
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1.  

2.  

3.  

1.  

2.  

3.  

4.  

Open the project  file of the add-in located at config.xml workspace

./JSXAPPS/PROJECT_DIR_/config.xml

Add this new record to the configuration file:

<record jsxid=  type= >"jsxversion" "string" 3.3</record>

Save the file.

You might also want to update your add-ins to use the new General Interface features, such as
class loading and relative paths. See  and Class Loading in Migration for 3.1.x to 3.4 Migration

.Relative Paths for 3.1.x to 3.4 Migration

Relative Paths for 3.1.x to 3.4 Migration

Now that General Interface Builder supports relative paths, you can update your project files to
use relative paths. Although this isn't required, specifying relative paths to application
resources increases the portability of code from one project to another and prevents problems
when renaming projects.

Modify paths in the following files:

Modify the path for the initial component in the Project Settings dialog (Project > Project
Settings) or the application configuration file. See Project Settings for 3.1.x to 3.4

.Migration
Modify paths in JavaScript code to use relative URLs. To update your code, remove this
portion of the path: .JSXAPPS/PROJECT_DIR_/

Modify paths in the component serialization files or in the Properties Editor palette to
use relative URLs.

For more information, see the General Interface Developer Guide.

Required Migration Steps for 3.1.x to 3.4 Migration

The following steps are required for updating your 3.1.x project to 3.3:

Open the 3.1.x project and project files in General Interface Builder 3.3 and resave all
project files.

If you're using Firefox and have files encoded in UTF-16, open the 3.1.x
project and project files in Internet Explorer first and resave the files before
opening in Firefox. See .Character Encoding

Specify class loading options to improve application performance with the new dynamic
class loading features in General Interface Builder 3.3. See Class Loading in Migration for

.3.1.x to 3.4 Migration
Modify records that specify auto loading in the application configuration file. New auto
load options have been added. See .Auto Load Options
If your projects use add-ins, update the add-ins as follows: 

Charting and custom add-ins If your project uses Charting or custom add-ins,

enable the add-in on the Add-ins panel of the Project Settings dialog (Project >
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4.  

5.  

6.  

7.  

1.  

2.  

3.  

4.  

enable the add-in on the Add-ins panel of the Project Settings dialog (Project >
Project Settings). 
Project settings Application configuration files must be modified for custom
add-ins to work in General Interface 3.3. See Project Settings for 3.1.x to 3.4

. Migration
Mapping add-in If your project includes data mapping, see Data Mapping for

.3.1.x to 3.4 Migration
If your projects have rules files, update all rules files. See Data Mapping for 3.1.x to 3.4

.Migration
If your projects use any custom XSL, you must update the XSL. See XSL Changes for

.3.1.x to 3.4 Migration

If any project files in your migrated project are displayed in red in the
Project Files palette, you need to update the references to those files.
Right-click the file in the Project Files palette and choose .Edit Profile
Modify the path in the URI field and click .Save

Migrate your updated 3.3 projects to 3.4. See .Migrating Projects from 3.2 or 3.3 to 3.4

Required Steps for Firefox for 3.1.x to 3.4 Migration

The following additional steps are required for updating your 3.1.x project to 3.3 for Firefox
deployment:

Open any files that are saved in UTF-16 encoding in Internet Explorer first and resave
the files before opening in Firefox. See .Character Encoding
Complete the required steps described in Required Migration Steps for 3.1.x to 3.4

.Migration
Replace all deprecated List and Grid components with Matrix components. List and Grid
are not supported in Firefox.
If you're using XSL files, verify that they meet certain requirements to work correctly in
Firefox. See .XPath and XSLT Requirements

There are also additional optional steps you can complete. See Optional Migration Steps for
.3.1.x to 3.4 Migration

XSL Changes for 3.1.x to 3.4 Migration

The General Interface XSL templates for the classes that implement the jsx3.xml.Cacheable
interface (Select, Menu, List, Grid, Matrix, and Tree) have changed in 3.2 and later releases and
are not backwards compatible. Existing custom templates must be recreated starting from the
default 3.3 XSL templates, which are located in the  directory. Because custom/JSX/xslGI_HOME

templates will not be supported in the future, this functionality is deprecated.

Introduced in General Interface 3.2, XML transformers are the preferred replacement for
custom XSL templates. XML transformers are used to transform the source XML of a GUI
control implementing the  interface before the XML is stored in the XMLjsx3.xml.Cacheable

cache. For example, a transformer could transform non-CDF source XML into CDF-compliant
XML or affect the visual style of the control by constructing a  CDF attribute from@jsxstyle

other information in the source document. For more information, see  injsx3.net.Cacheable
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other information in the source document. For more information, see  injsx3.net.Cacheable

General Interface API Reference and the inline IDE documentation for the XML Transformers
property in the Properties Editor palette.

For Firefox, XSL must meet certain requirements. See .XPath and XSLT Requirements
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1.  
2.  

3.  

4.  

5.  

6.  
a.  

b.  

c.  

1.  

2.  

Chapter 4 Migrating Projects from 3.2 or 3.3 to 3.4

This chapter explains how to migrate your 3.2 and 3.3 projects to General Interface 3.4. The
migration path is 3.2 or 3.3 > 3.4. No migration is needed from 3.2 to 3.3.

Installation and Set Up to Migrate from 3.2 or 3.3 to 3.4
Migration Steps to Migrate from 3.2 or 3.3 to 3.4

Installation and Set Up to Migrate from 3.2 or 3.3 to 3.4

Complete these steps to migrate your General Interface 3.2 or 3.3 projects to 3.4:

Make backup copies of all projects you are migrating.
Install General Interface 3.4. For more information about installing General Interface, see
the General Interface Installation Guide.
Double-click  or  in the installation directory to startGI_Builder.html GI_Builder.xhtml

General Interface Builder in Firefox or Internet Explorer.
Choose or create a workspace directory after General Interface Builder initializes. For
more information on workspaces, see the General Interface Developer Guide.

Create a new workspace to get the updated 3.4 sample applications.
Choosing an existing workspace doesn't replace previous sample
applications with updated 3.4 sample applications. This built-in
functionality is designed to prevent workspace files from getting
overwritten.

If you chose an existing workspace, copy any custom add-ins to the 3.4 JSX/addins
directory. Typically, add-ins to be used by a team of developers would be saved to the 

 directory and posted by an administrator to a location accessible to the team.JSX/addins

If you created a new workspace, complete these steps: 
Copy projects that you would like to migrate to 3.4 from your previous workspace

 folder into your new  folder. /JSXAPPS /JSXAPPSworkspace

Copy any custom user prototypes from your  directory to/prototypesworkspace

the new  directory. Components saved to this folder display/prototypesworkspace

in the  folder of the Component Libraries palette. User

Copy any custom add-ins to the 3.4  or new JSX/addins /addinsworkspace

directory. Typically, add-ins to be used by a team of developers would be saved
to the  directory and posted by an administrator to a location accessibleJSX/addins

to the team. Add-ins for individual use can be saved to the /addinsworkspace

directory.

Migration Steps to Migrate from 3.2 or 3.3 to 3.4

The following steps are required for updating your 3.2 and 3.3 project to 3.4:

Update the project for changes to class loading.

Review  to see if your applications are affected by changes toChanges in Behavior in 3.4
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2.  

3.  

4.  

5.  

1.  
2.  

Review  to see if your applications are affected by changes toChanges in Behavior in 3.4
General Interface 3.4.
If your application creates a LayoutGrid - Side/Side component programmatically using
the constructor instead of being deserialized from an XML file, call the setCols()
method and pass an asterisk as the parameter to match the 3.3 behavior: .setCols("*")

Otherwise, an extra row will be added to the layout. Note that the setDimensionArray()
method has been deprecated in 3.4 and is replaced with the  and setCols() setRows()

methods.
Optional Rewrite any JavaScript code that uses deprecated APIs. See Deprecated APIs in
General Interface Release Notes.
Optional Replace any Block components that use an iframe with the new IFrame
component.

Class Loading

There are two changes to class loading in 3.4:

The At Lt Init and At Full Init Auto Load options are no longer supported. If your project
uses these class loading options, see .Auto Load Options
The jsxlt parameter is no longer supported. If your deployed projects use ,jsxlt="false"

see . If your project uses , no changes are needed.jsxlt Parameter jsxlt="true"

Auto Load Options

The Auto Load options for JavaScript files, At Lt Init and At Full Init, are no longer supported.
If you've used these settings in your project, you need to reset the JavaScript file to Auto Load
(At Init).

To change the Auto Load setting to At Init, complete these steps:

Right-click the JavaScript file in the Project Files palette.
Choose Auto Load from the context menu. The file name now displays in a bold font in
the Project Files palette.

jsxlt Parameter

The jsxlt launch parameter is no longer available as of 3.4. All applications now load in the 
 mode. If you deployed your project using , use  tojsxlt="true" jsxlt="false" jsx3.require()

explicitly load classes, so that the project is compatible with dynamic class loading. See 
.jsx3.require() Method

Changes in Behavior in 3.4

To see if any of these changes affect your applications, run your applications in General
Interface 3.4 and check the following behaviors. Then modify your applications as needed.

Menu 
Menu positioning and cascading may be different. See GI-63 in General Interface
Release Notes. 
Long menus now render with auto-scroll arrows instead of with scroll bars.

TabbedPane 
Provides an automatic right and left scrolling mechanism for navigating through
tabs that are hidden when they exceed the viewable space.

Tree 
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Tree 
Support for range selection using Shift+click and multiple selection using
Ctrl+click. 
Support for drag-and-drop of multiple records. 
Drag-and-drop insertion between nodes and insertion as last child of node. 
Context menu can operate on multiple rows.

Dialog 
When deserialized a dialog box top-left position could be at a negative position if
the min-width and min-height were larger than the client window and no top-left
positions were defined. Left and top are now never less than zero. However, since
the resize control is in the bottom right, call  if there is aconstrainPosition(true)

chance that the dialog is larger than its parent.
Form elements 

All form elements now inherit font color from an ancestor block.
setValue() and Matrix 

If a Matrix is a single selection and the passed value is an array with more than
one element, an illegal argument exception is now thrown.

jsx3.app.Model.getChild() returns null instead of undefined. Unless specifically
documented, application should be careful about checking against undefined or null
value returned by General Interface functions. Developer should check against known
value.
For example, instead of this:

if (objJSX.getChild('block') == )null

or

if ( (objJSX.getChild('block')) == 'undefined' )typeof

Do this instead:

if ( !(objJSX.getChild('block')  jsx3.app.Model) )instanceof

or

if ( ! (objJSX.getChild('block') )

For more information on new features, changes in functionality, and known and closed
issues, see General Interface Release Notes.
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Chapter 5 Migrating Projects from 3.x to 3.5

Migrating from General Interface 3.4 to 3.5 requires no migration—simply open version 3.4
projects in 3.5.

To migrate from 3.0 to 3.5, follow the instructions in Migrating Projects from 3.0 to 3.4
To migrate from 3.1 to 3.5, follow the instructions in .Migrating Projects from 3.1.x to 3.4
To migrate from 3.2 or 3.3 to 3.5, follow the instructions in Migrating Projects from 3.2 or
3.3 to 3.4
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Chapter 6 Migrating Projects from 3.x to 3.6-3.8

This chapter describes how to migrate General Interface projects to version 3.6-3.8.

To migrate from 3.0 to 3.6-3.8, follow the instructions in Migrating Projects from 3.0 to
.3.4

To migrate from 3.1 to 3.6-3.8, follow the instructions in Migrating Projects from 3.1.x to
.3.4

To migrate from 3.2 or 3.3 to 3.6-3.8, follow the instructions in Migrating Projects from
.3.2 or 3.3 to 3.4

To migrate from 3.5 to 3.6-3.8, see .Changes in Behavior for Migration to 3.6-3.8

No steps are required when migrating from 3.6 or 3.7 to 3.8.

Changes in Behavior for Migration to 3.6-3.8

The following changes in behavior apply to migration from 3.5 to 3.6-3.8

The  file has been deprecated in General Interface 3.6-3.8, so<resourcename>.meta.xml

that localized applications that use the file will fail to display localized text.

If you use  in your application, update the application to add the <resourcename>.meta.xml

 specification in the main resource properties file. For example:locales

<data jsxid=  jsxnamespace="jsxroot" "propsbundle"

locales= >"fr,zh_TW"

<locale>

<record jsxid=  jsxtext=  type= />"Line1" "This old village" "jsxtext" <record jsxid=
 jsxtext=  type= />"Line2" "not a single house" "jsxtext" <record jsxid=  jsxtext="Line3"

 type= />"without persimmon trees" "jsxtext" <record jsxid=  jsxtext="Dialog1" "Dialog
 type= />Title (No Chinese or French value available)" "jsxtext" <record jsxid="Tools1"

jsxtext=  type= />"Tools" "jsxtext" <record jsxid=  jsxtext="Display English" "Display
/>English" <record jsxid=  jsxtext= />"Display Chinese" "Display Chinese" <record jsxid=

 jsxtext= />"Display French" "Display French" <record jsxid=  jsxtext="Display Default"
/>"Display Default" <!-- demonstrates fall-through ></locale></data>

* XML load API uses different protocols in 3.6-3.8 than in previous versions. For releases
through GI 3.5.1, the native XML Document object is used and loads XML resources
synchronously. Relative path XML resources are resolved relative to the JavaScript code or
project configuration file.

For releases starting with 3.6,  is used to load XML resources. The majorjsx3.net.Request

advantage is that this allows for asynchronous loading of resources. However, this also changes
the relative path resolution to be relative to the launch HTML page location.



21

Copyright © TIBCO Software Inc. All Rights Reserved.

If your application uses a relative path for the XML resource, you must update the
relative path to be resolved by calling 

 before passing it to load<my_application_server>.resolveURI(<my_relative_path>)

method such as . It is a recommended good practice to always use Document.load()

 to specify the resource URL.resolveURI()

In 3.5, a component loaded from a URI beginning with  has its URI resolverJSXAPPS/...

set to the application server. In other words,  returns the serverModel.getUriResolver()

of the component when called on the component. Therefore, any path resolved against
the component will resolve relative to the project directory.

Beginning with Release 3.6, a component loaded from a URI beginning with  has itsJSXAPPS/...

URI resolver set to . Therefore, any path resolved against thejsx3.net.URIResolver.USER

component will resolve relative to the user workspace.

A URI beginning with  is considered to be absolute (the same as JSXAPPS/...

) and is supported only for legacy reasons.jsxuser:///JSXAPPS/...

Specifically, f you load a component from a URI beginning with , paths that resolveJSXAPPS/...

against the component and are relative to the project directory no longer work. The following
examples show methods with path parameters that are resolved against the component, such as

, , and .Model.load() Cacheable.setXMLId() ToolbarButton.setImage()

For example, the following works in 3.5, but will not work in 3.6-3.8

var dlg = myApp.getBodyBlock().load("JSXAPPS/sampleApp/components/dialog.xml");

  dlg.load("components/matrix.xml");

Instead, the recommended approach is to load all components with project-relative URIs:

var dlg = myApp.getBodyBlock().load("components/dialog.xml");

  dlg.load("components/matrix.xml");

The following deprecated option uses all legacy URIs:

dlg = myApp.getBodyBlock().load("JSXAPPS/sampleApp/components/dialog.xml");

  dlg.load("JSXAPPS/sampleApp/components/matrix.xml");

For , which accepts an optional URIResolver parameter, you can explicitly specifyModel.load()

the resolver:

var dlg = myApp.getBodyBlock().load("JSXAPPS/sampleApp/components/dialog.xml");

  dlg.load("components/matrix.xml", , myApp); // 3rd parameter is the resolver.true
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